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Chapter 1 - About this guide

1.1

1.2

1.3

About this guide

Read me first

Please read this guide carefully before using the device to ensure safe and proper use. Softing does not
assume any liability for damages due to improper installation or operation of this product.

This document is not warranted to be error-free. The information contained in this document is subject to
change without prior notice. To obtain the most current version of this guide, visit the download center on
our website at: http://industrial.softing.com/en/downloads

Target audience

This guide is intended for experienced operation personnel and network specialists responsible for
configuring and maintaining field devices in process automation networks. Any person using a PROFINET
Gateway must have read and fully understood the safety requirements and working instructions in this
guide.

Typographic conventions

The following conventions are used throughout Softing customer documentation:

Keys, buttons, menu items, commands and other Open Start > Control Panel > Programs
elements involving user interaction are set in bold font
and menu sequences are separated by an arrow

Buttons from the user interface are enclosed in Press [Start] to start the application
brackets and set to bold typeface

Coding samples, file extracts and screen output is set MaxDlsapAddressSupported=23
in Courier font type

File names and directories are written in italic Device description files are located in C:
\<Application name>\delivery\software\Device
Description files

fi CAUTION
CAUTION indicates a potentially hazardous situation which, if not avoided, may result in minor
or moderate injury.

Note

This symbol is used to call attention to notable information that should be followed during
installation, use, or servicing of this device.

Hint

) This symbol is used when providing you with helpful user hints.

m Video

This symbol refers to a video on the corresponding topic.

Version EN-032024-1.31-1 5
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1.4 Document history
Document version Changes since last version
1.00 First version
1.01 New Corporate ldentity implemented.
1.10 External references added.
1.20 Description and instructions of pnGate PB model added.
1.21 Corrections and additions of video references
1.22 Maximum permissible ambient temperatures changed for horizontal and vertical
. . i 14 .
mounting of gateways. See Installation positions - for details.
1.30 Document restructured. Editorial changes. Chapter on GSDML file update and
u@loadD31 and chapter on switching from a 2-channel to a 4-channel
,qatewavDe'3 included. RJ45 status LEDsE™ explained.
1.30-1 Communication portD17 details added.
1.30-2 Corrections in Chapter About PROFINET GatewavsD7 and Softing contact
address changes
1.30-3 Diagrams in Chapters Connection diagram pnGate PAD1O and Connection
diagram pnGate pgl™ updated
1.31 Chapter 5.4 Asset management with ABB FIME* added.
1.31-1 Minor editorial changes.
1.5 Related documentation and videos
See the following links for additional product information:
= Documents
1.6 Document feedback
We would like to encourage you to provide feedback and comments to help us improve the
documentation. You can write your comments and suggestions to the PDF file using the editing tool in
Adobe Reader and email your feedback to support.automation@softing.com.
If you prefer to write your feedback directly as an email, please include the following information with
your comments:
= document name
= document version (as shown on cover page)
. page number
6 Version EN-032024-1.31-1
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Chapter 2 - About PROFINET Gateways

2 About PROFINET Gateways

The PROFINET Gateway is a host interface for integrating PROFIBUS PA and PROFIBUS DP segment devices
in PROFINET systems. The Softing PROFINET Gateway is available in three models:

The pnGate PA model is available in as a 2-channel and as a 4-channel version. Both versions
integrate PROFIBUS PA (Process Automation) segments in PROFINET systems at a fixed speed of 31.2
kbit/s, typically used in areas of process automation with explosive atmosphere.

The pnGate PB integrates PROFIBUS DP (Decentralised Peripherals) networks in PROFINET systems
at speeds of up to 12Mbit/s, typically via a centralized controller in factory automation. Additionally it
also integrates PROFIBUS PA segments in PROFINET systems.

The pnGate DP integrates one PROFIBUS DP (Decentralised Peripherals) network with up to 32
PROFIBUS DP devices in PROFINET systems at speeds of up to 12Mbit/s.

All three PROFINET Gateways support industry-standard device configuration, parametrization and
condition-monitoring tools. In addition, the gateway user interface helps supports the conversion of
PROFIBUS GSD files to a single generic PROFINET GSDML file.

Engineering systems and asset management systems

The gateways can be managed with the following tools:

PROFINET engineering systems (e.g. Siemens TIA Portal)
FDT frame application (e.g. PACTware)
Siemens SIMATIC PDM (Process Device Manager)

2.1 Intended use

This series of gateways has been designed to integrate to integrate PROFIBUS devices into PROFINET-
based networks. Any other use is not intended. Follow the instructions in this document on how to
configure and operate the gateways.

ff CAUTION
Do not use this device in hazardous areas! See Section Sgecificationst for permissible

ambient conditions.

2.2 System requirements

These gateways require the use of a PROFINET engineering system such as the Siemens TIA portal (version
15 or higher) and STEP 7 (version 5.5 SP 4 or higher). Engineering systems from other PLC vendors can also
be used, provided they support PROFINET GSDML files. Further requirements include:

24V power supply

one power conditioner per PROFIBUS PA segment
field barrier (for Ex environment)

PC with web browser

GSD file for each PROFIBUS device on your network

Javascript must be activated

Version EN-032024-1.31-1 7
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2.3 Supported features

The PROFINET Gateway maps PROFIBUS devices to PROFINET networks. All gateways support the
conversion of PROFIBUS GSD files into a single PROFINET GSDML using an integrated web-based
conversion tool. Other supported features include:

Ll Simple connection to PROFIBUS PA and PROFIBUS DP devices using PROFINET controllers
Ll Integration in FDT frame applications

= Integration in Siemens SIMATIC PDM

Ll Configuration of the gateway in a web browser

. Integrated configurator to start up the PROFIBUS devices

Ll Detailed display of the operation state by LEDs

= Two Ethernet interfaces (switched internally)

Ll Power supply by connectors or rail connectors

2.4 Specifications

Power supply 18 VDC...32 VDC; SELV/PELV supply mandatory
Typical input current is 200 mA; maximum is 1 A
(considering the rush-in current at switch-on).
Ethernet IEEE 802.3 100BASE-TX/10BASE-T

Minimum ambient operating temperature -40 °C (see section Installation positionsD14 for the
maximum ambient temperature depending on the
mounting position)

Storage temperature -40 °C...+85 °C

Altitude Must not exceed 2,000 m

Location Indoor use only; no direct sunlight

Safety standard IEC/EN/UL 61010-1 Safety requirements for

electrical equipment for measurement, control and
laboratory use - Part 1: General requirements and
IEC/EN/UL 61010-2-201 Safety requirements for
electrical equipment for measurement, control and
laboratory use - Part 2-201: Particular requirements
for control equipment (both with CB scheme).

2.5 Safety precautions

ij CAUTION
During operation, the device's surface will be heated up. Avoid direct contact. When servicing,
turn off the power supply and wait until surface has cooled down.

Do not open the housing of the PROFINET Gateway. It does not contain any parts that need
to be maintained or repaired. In the event of a fault or defect, remove the device and return it
to the vendor. Opening the device will void the warranty!

8 Version EN-032024-1.31-1



Chapter 3 - Installation

3 Installation

3.1 Hardware installation

With an ambient temperature above 55 °C at the place of installation connecting cables may
heat up strongly if they are installed in an unfavourable position. In such cases, ensure that

the permissible service temperature of the cables (i.e. 80 °C) is not exceeded or use cables
sustaining high temperatures of at least 90 °C.

3.1.1 Mounting and dismounting

Note
Make sure the PROFINET Gateway is mounted in such a way that the power supply can be easily
disconnected.

Note
Depending on the installation position, the maximum ambient operating temperature may
differ. See Section Installation positions D" for details.

Installation and inspection

Installation and inspection must be carried out by qualified personnel only (personnel qualified
according to the German standard TRBS 1203 - Technical Regulations for Operational Safety).
The definition of terms can be found in IEC 60079-17.

> @ @

Mounting
1. Hook the upper notch of the cut-out on the back of the
PROFINET Gateway into a 35 mm DIN rail. 3‘\ )
\
)
2. Pressthe PROFINET Gateway down towards the rail until it 5 ¥

slides into place over the lip of the locking bar.

\
_ 2
Note 1| ral

Do not put stress on the system by bending or torsion.

Dismounting

1. Slide a screwdriver diagonally under the housing into the

locking bar.
2. Leverthe screwdriver upwards, pull the locking bar El
downwards - without tilting the screwdriver - and move

the gateway upwards off the rail.

Version EN-032024-1.31-1 9
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3.1.2 Connection diagrams pnGate PA

The following diagram shows the input and output interfaces of the pnGate PA. The 2-channel model has 2
physical PROFIBUS segment connections (PAO to PA1), while the 4-channel model has 4 physical PROFIBUS
segment connections (PAO to PA3).

2-channel model

Power Supply Redundancy

24V DC Link (RDL)
GND L L+ GND TX RX
123 456

C > Q'()-O—\

—C

Rail

Power
Supply GND
24VDC L+

ETH1

ETH2

I_ I_VV

151413 9 8 7 Fieldbus
- S+ -8+

= =

4-channel model

Power Supply Redundancy

24V DC Link (RDL)
GND L L+ GND TX RX
123 4586

\ ’ 8

+C

Rail

Power
Supply GND
24v DC L+

ETH1

I_ I_\JV

ETH2

181716 151413 121110 9 8 7 Fieldbus
-8+ -8+ -8+ -8+

= P

3.1.3  Connection diagram pnGate PB

The following diagram shows the input and output interfaces of the pnGate PB. The gateway has 2 physical
PROFIBUS PA segment connections (PAO to PA1) and supports on RS-485 link for PROFIBUS DP data
communication.

10 Version EN-032024-1.31-1
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Power Supply Redundancy

24V DC Link (RDL)
GND L L+ GND TX RX
123 456
A 4 A
D
- H
Rail
Power - _J ETH1
Supply GND i
24V DC L+ 1 {op
PA1  PAO
\ J ETH2

i/

151413 9 8 7 Fieldbus
- g+

g

3.1.4 Connection diagram pnGate DP

The following diagram shows the input and output interfaces of the pnGate DP. The gateway has two

10/100 Base-T Ethernet ports (ETH1/ETH2) and one RS-485 link for PROFIBUS DP data communication. The

RJ45 ports correspond to IEEE 802.3 and are connected to an internal switch for line topologies.

Power Supply Redundancy
24v DC Link (RDL)

GND L L+ GND TX RX
123 456

D
+—C h
Rail
Power ,._.._ﬂ ETH1
Supply GND !
24VDC L+ 1 ipp
J ETH2

/

3.1.5 Connecting the power supply
Connect the gateway to a 24 V DC power supply (not included in the delivery).The supply voltage (18 VDC

.... 32VDC) is connected by a 3-pole terminal block. The power supply is connected to the plug connector

via flexible wires with a cross section of 0.75 to 1.5 mm?2. The ground connection wire must have a cross
section of 1.5 mm?.

Version EN-032024-1.31-1
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by
XV I3

Signal Description

GND Ground

L Functional earth

L: Positive supply voltage

A\
o
o

= &

CAUTION

The Functional Earth (FE) connection of the device has to be connected at low inductance

with the Protective Earth (PE) of the system.

Note

As the connection diagrams show, the power can also be applied by a special DIN rail
connector (Rail Power Supply). For further information contact Softing Industrial Automation

GmbH.

Note

See also the maximum ambient temperatures in the Section Installation positions

M4

12
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3.1.6

Connecting to the network

1. Connect each segment of your PROFIBUS network to a port of your gateway. Be sure that each
segment is powered by a power conditioner. If you connect to field devices in explosive atmospheres
ensure that you also connect a field barrier in between.

2. Connect the gateway from one of the two Ethernet ports with your PROFINET network.

3. Connect your PC running the engineering and asset management tools using the second Ethernet port.

pnGate PA network topology

[P —— = = ==] PlantAsset Management

| e.g. TIA Portal =C2g0 ﬁ_w ]AMS

*PDM rreri Suit

ETHERNET

PAC / PLC E@g

i

naE
PROFINET PROFINET PROFINET &) %i\ {(/ .
Device Device Device s E 1 7]
\ § | /% ¥ pnGate PA
Y 53

Power
Conditioner

A"
¥EN

. f/

r

PROFIBUS PA
: @ : Field Barrier
] 1 ¢
i i atosa
] 1
] 1
1 Field Device  Field Device  Field Device | PROFIBUS PA
L

Plant Asset Management

ENGINEERING
"| e.g. TIA Portal

ETHERNET

PAC/PLC

PROFINET PROFINET
Device Device

PROFINET

Power
Conditioner

PROFIBUS DP

1N ]
& il %=
L[

Field Device Field Device

Field Barrier

Field Device Field Device PROFIBUS PA
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pnGate DP network topology

Plant Asset Management

< =0 ]AMS

“PDM paar: Suite

ENGINEERING
| e.g. TIA Portal

ETHERNET

PAC / PLC

-

PROFINET

PROFINET PROFINET PROFINET
Device Device Device
—
$" B
en
pnGate DP ‘4 bt
) &
N i
\ ~ PROFIBUS DP
) l@ @ %
R
Field Device Field Device Field Device

3.1.7 Installation positions

PROFINET Gateways can be mounted horizontally and vertically. Depending on the installation position,
different ambient operating temperatures (T, ) are allowed.

@ Minimum distance
Provide a minimum distance of 50 mm to the air inlet and air outlet to ensure natural
convection.
Rotated installation position

The maximum permissible ambient temperature values also apply to a 180° rotated
installation position.

Horizontal installation position and maximum temperatures

14 Version EN-032024-1.31-1
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3.1.8

Number of PA Maximum PA fieldbus Minimum distance Maximum ambient
channels used voltage temperature T,
0-4 32VDC 0mm 50°C
0-2* 24VDC 0mm 55 °C
0-4 32VDC 17.5mm 60 °C
0-2* 24VDC 17.5mm 60 °C

* pnGate DP models have no PA channel

Vertical installation position and maximum temperatures

Ee e e e &&&m—n&u‘ﬂ
v

Number of PA Maximum PA fieldbus Minimum distance Maximum ambient
channels used voltage temperature T,
0-4 32VDC 0 mm 40 °C
0-2* 24VDC 0 mm 45 °C
0-4 32VDC 17.5 mm 50 °C
0-2* 24VDC 17.5 mm 55 °C

* pnGate DP models have no PA channel

Powering up the device

Turn on the power supply. The boot process will take around 15 seconds. For indication of proper
. T 53
operation refer to LED status indicators— .

Version EN-032024-1.31-1
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3.2

Software installation

Note
When you install a Softing product for the first time, you will be asked if you trust the publisher.

Activate the option Always trust software from Softing AG if you do not want to be asked in
subsequent installations and select [Install] to start the installation.

Go to the pnGate web page to download the latest product software.

Start by downloading and installing the Search and Configure tool.
Follow the on-screen installation instructions.

Read the license agreement carefully.
If you have questions, you can [Cancel] the installation at this point and contact us. Click [Print] if
you want to print the license agreement to a PDF or on a printer.

Select | accept the terms in the license agreement and click [Next].

Click [Install] to install the selected software application on your PC.

While the installation is in progress, the status bar of the installation wizard shows the different steps
that are being executed. If you want to abort the installation, click [Cancel] button. The installation
wizard will undo all modifications that have been made to your computer up to this point. Otherwise,
wait until the installation is completed.

Press [Finish] to complete the installation and exit the wizard.

Note
Proceed with the installation of the other software packages.

Additional installations
Depending on your use case, install one of the following software packages:

Install an FDT frame application if you are using FDT technology.

Install PROFIdtm separately if you are not using PACTware but another FDT frame application like
FieldCare or FieldMate.

Install PDM libraries for integration into Siemens PDM.

16
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Chapter 4 - Configuration

4 Configuration

The PROFINET Gateway connects to an integrated web server to configure the gateway and the connected
PROFIBUS devices. One of the functions of the web server is to convert PROFIBUS GSD files into a single
PROFINET GSDML file. The configuration is typically done offline in the PROFINET engineering system (e.g.
Siemens TIA Portal) meaning that you do not need to be connected to a controller or a gateway.

The default IP address of the integrated web server is 192.168.0.10. To access the PROFINET Gateway
from your PC, you either have to change the default IP address of the integrated web server to an address
on your network or change the DHCP address on your PC to a static IP address that matches the network
address of your gateway (e.g. 192.168.0.1). The following Chapter describes how you have to do one of
the two options.

4.1 Prerequisites
. Ensure that you have downloaded and installed the latest firmware.

. The PROFINET Gateway is connected to the PROFIBUS PA or PROFIBUS DP segment.

. The PROFINET Gateway is connected with a PC which runs a standard Internet browser supporting
JavaScript.

. The Search and Configure tool is installed.

. GSD files (electronic device descriptions) corresponding to the PROFIBUS devices are available on the
PC.

. The PROFIBUS devices are connected to the PROFIBUS PA or PROFIBUS DP segment.

PROFINET Gateway requires the following communication ports to be available:

Application _ Port Type

Web Interface 80/443 TCP
Search and configure 1900, 2355,5353  UDP/Multicast
PDM, DTM 2357 TCP
Modbus Communication 502 (default) TCP

Version EN-032024-1.31-1 17
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4.2 Changing the IP address of the PROFINET Gateway
Before you can configure the connected PROFINET Gateway you will have to change the preset IP default
address of your gateway so that the integrated web server can communicate with your PC over the Local
Area Network.
Searching for devices
The following steps apply to Windows 10.
1. Click Start > Softing > Search and Configure.
The application window is opened.
'. Search and Configure &@g
Connected devices in local network:
MAC Address Device Type Serial Number Mame IP Address 1P Mask Gateway
Network Adapter Selection: Office : 172.17.1.218 -
Search Configure Canfigure via CSV fille About Close
2. Open the Network Adapter Selection.
3. Select the network on which you want to search for the connected gateway.
This selection menu shows all networks you can access from your PC.
4, Click [Search] to start searching for connected devices.
The search may take some time. The window Connected devices in local network appears.
@ search and Configure - O b e
Connected devices in local network:
MAC Address Device Type  Serial Number IP Address 1P Mask Gateway
oo | s oner || omer | om0 |
Network Adapter Selection: Ethernet 5 : 192.1658.0.1 -
Search Configure Configure via CSV file About Close
5. Select the network device you want to configure.
6. Click [Configure] or double-click the device.
The configuration window opens. Here you can modify all relevant values.
@ Configuration of pnGatePA (pnGate PA) ? X
Hew Values Current Settings
Host name pnGatePA pnGatePA
1P address |192.168.0 .10] | [172.17.5.64
Subnet mask: 255.255.0 .0 255.255.0.0
Default gateway address 0.0.0.0 0.0.0.0
Maintenance IP address 0.0.0.0 0.0.0.0
Use DHCP v
HW version 100
User name administrator
Password LLITITTS
| Submit Cancel
18
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Note
If you are starting the connected PROFINET Gateway for the first time and you have
not yet assigned user roles for the gateway, the user name in the configuration

window is preset to administrator.
7. Enter the default password FGadmin!1 for username administrator.

8. Click [Submit].
The changed settings are written to the device.

Note
For the PROFINET communication to work properly ensure that the device's web

server does not use the same IP address that is used by the PROFINET engineering
system (e.g. TIA Portal) for the gateway.
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4.3 Setting the IP address of the PC

If you have not changed the IP address of a PROFINET Gateway as described in the previous Section™™®

you will need to configure the IP address of your PC to access the gateway from your PC.
The following chapter describes how to set a static IP address in Windows 10.
1. Click Start > Windows System - Control Panel from your task bar.

2. Select Network and Internet -> Network and Sharing Center.
A new window opens where you can view your basic network information.

3. Click on your Internet connection (either Ethernet or wireless) next to Connections under View
your active networks.
A new window opens.

4, Click [Properties].

5. Select Internet Protocol Version 4 (TCP/IPv4).
The following window opens.

Internet Protocol Version 4 (TCP/IPvE) Properties LM

General
You can get IP settings assgned automabeally if your network supports
this

capabiity. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

Obtain an IP address automatically
I @ Use the following P add'ess:l

IP address: 192,168, 0 . 1
Sibnet mask: 255 .255.255 . 0
Default gateway:

@ Usg the following DNS server addresses:
Preferred DS server:

Alternate DINS server:

Validate settings upon exit | Advanced. .. =

6. Select Use the following IP address and enter a specific IP address and Subnet mask. In our
example we use the following settings:
IP Address: 192.168.0.1
Subnet mask: 255.255.255.0

7. Click [OK] to confirm.
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4.4 Login to user interface

1. Open your Internet browser and enter the IP address of your gateway.

Note
@ If you don't recall the IP address of your gateway, start the tool to find out what it is
(see Step 2 below).

2. Click the IP address of the gateway to launch the login window in your web browser.
. Search and Configure I} E@
Connected devices in local network:
MAC Address Device Type erial Numbe: Name IP Address IP Mask Gateway

1/00-06-71-2d-... FG-200 HS.. 141800051 fg-x00-1418000.. 172173051  255.255.0.0  17217.0.160
2 00-06-71-2d-... FG-200 HS.. 160700161 fg-x00-1607001.. 17217113 255.255.00 0.0.0.0

3 00-06-71-ff-0.. mbGate PA.. 172600266 mbgatepal7260.. |17217.1.158| 255.255.00  172.2013.110

Network Adapter Selection: LAN-Verbindung : 172.17.3.72 hd
Search Configure Configure via CSV file About Close
3. Select the administrator symbol and enter FGadmin!1 in the password field.

administrator config view
(Administrator) (Maintenance) (Observer)

User Name: |administrat0r |

Password: | |

The gateway's web-based interface opens with the information page.
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4.5 Changing the password
1. Log on to the web interface of the gateway.
2. Select Settings > User Accounts.
As administrator you can change and confirm the passwords for different roles.
See details below.
administrator config WiEw
(Administratory (Maintenance) (Ohserver)
User name I
Old password | oy
Mew password I o
Confirm new password I FY
3. Click one of the icons (administrator, config or view) and enter the Old Password and the New
Password in the corresponding fields..
4, Retype the password in the Confirm new password field and click [Apply] to save the modified
password.
Be careful when changing the administrator password! If you lose your changed
administrator password, you can no longer make changes to configurations or settings. In
this case contact Softing support.
Access to your PROFINET Gateway configuration tool is managed by user roles where each role has
certain permissions. The following user roles are available:
Role Username Password
Administrator administrator FGadmin!1l
Maintenance config FGconfigll
Observer view FGview!1l
Additionally, your PROFINET Gateway can be accessed remotely with the user roles Diagnostics (user:
diagnosis, psw: ?<fJ#\/SeB2qgtGd*)and Expert (user: expert, psw: FS-QsHnc7BWa { 6w<). Both
user roles are reserved strictly for Softing Support purposes.
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It is strongly recommended to change the Diagnostics and Expert passwords immediately by
entering the user name in the input field instead of selecting one of the icons above.

The following table shows the permissions/actions of each user role:

Permission Administrator Service Engineer Observer

Setting password 4}

Configuring gateway

X
&

Reading configuration

Reading diagnostics

Updating firmware

Resetting gateway

| |R|E|E

Installing HTTPS certificates
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4.6 Updating the firmware

The gateway comes with pre-installed firmware which is maintained and updated to continuously enhance
the functionality of the device. To ensure that your PROFINET Gateway is always running the most recent
version check the Softing Download Center for the most recent firmware update.

You need to be logged in as administrator™?".

1. Download the firmware update to your computer.
When you are downloading from this site for the first time you will have to register yourself in a
few steps.

2. Log on to the web interface of the gateway.

3. Select Settings > Firmware in the side bar navigation.

Firmware Update

Chooie Firmware File...

Current Firmware: 1.20.00.8095
Firmware File: No file selected.
Firmware Name:

Firmware Signed:

Firmware Encrypted:

4, Click [Choose Firmware File...] to select the firmware file you want to download.

5. Click [Update] to download the firmware file and to reboot the system.
The system performs a firmware file check. The download starts automatically. When the
download is completed the pnGate PA/pnGate PB/pnGate DP will be rebooted. When the boot
process is completed, the RUN LED is ON.

Note

Do not access the web server of the pnGate PA/pnGate PB/pnGate DP before the "Success"
message is displayed in the browser window. Otherwise you will have to clear the cache of
your web browser after the boot process has finished and reconnect to the web server of
the pnGate PA/pnGate PB/pnGate DP.
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4.7

4.7.1

4.7.2

PROFINET configuration in the TIA Portal

The following chapter describes how to convert the GSD file of a PROFIBUS PA or PROFIBUS DP field
device to a GSDML using the built-in PROFIBUS configurator and how to use this file to configure a
PROFINET device in the Siemens TIA Portal (Totally Integrated Automation Portal).

m Video

See also the videos Conversion from PROFIBUS GSD to PROFINET GSDML and PROFINET
configuration in the TIA Portal.

Prerequisites

. You must have installed the Siemens TIA Portal on your PC to optimize the PROFINET configuration
routines.

. You must know how to create and manage projects in the TIA Portal.

Creating a GSDML import file
1. Log on to the user interface of the gateway with your username and password.

2. Select PROFIBUS - Configuration.

pnGate PA 4xPA Information Settings Diagnosis PROFINET IO PROFIBUS

iews Configuration

Log Engingering system: [ TIA Portal, PCS 7, =] Plantname:  |[PDM_DTM_Testrack

Configuration Device Catalog Segment Configuration

Actions g Cerabar i =T Segment PAD Segment PA1
Manufacturer: Endress+Hauser Idderit Mumber: Ox151c
“ersion: Profile 3.0 GED File Name: EH3X151C GSD »
Import G50 % & FEK Starter Kit
Remove All G50s g Cerabar 5, 2nd Generation PA 4 Address: o 2 Devics T,
Manufacturer: Endress+Hauser Icderit Mumber: Ox1501
Clear Configuration ‘arsian: Profils 30 GED File Mame: EH3_1501 GSD
Load Configuration >
Deltapilot S P 4
Save Configuratian Manutacturer: Endress+Hauser  Ident Mumber: 01503
Wersion: Profibus 320 File Name: EH__1503 G50
Generic GSDML
>
GSOML ESK3-PA PA 4 ‘
3. Determine for which engineering system and for which installation (plant name) you want to
generate a GSDML import file. The engineering system in the configuration page is set by default to

the TIA Portal.

As each engineering system often only supports a specific GSDML format, it is

recommended that you select the engineering system you are using before converting the
imported GSD files.

4, Click [Import GSD] in the side menu.
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Select the file(s) you want to import in the File Upload window and confirm the upload to the
Device Catalog of your application clicking [Open]. You can add up to 64 files for conversion. The
selected file appears under Device Catalog.

Click [Generic GSDML] in the side menu to generate a single GSDML file from the GSD files in the
Device Catalog. If the GSMDL file is not automatically saved, save it manually to your PC.

Alternatively, click [GSDML] in the side menu to generate a single GSDML file from the GSD files
used in the Segment configuration.

Note

By selecting [Generic GSDML] you will generate a GSDML file from all the devices in the
device catalog. Remember that the PROFIBUS configuration of the segments is not
stored in the GSDML which implies that the assignment of the devices to the PROFIBUS
channels and the parameters of the devices must be done in the PROFINET engineering
system (e.g. TIA portal). If you choose to convert the GSD files to a static GSDML file
using the [GSDML] function the PROFIBUS devices and the used 10 modules cannot be
manually altered later in the PROFINET engineering system (e.g. TIA portal).

4.7.3 Creating a new project in Siemens TIA Portal

Open or create a new project in the TIA Portal using the PROFINET Controller.

1.

2.

Start the TIA Portal.
Click [Create new project].
Enter a project name and path.

Click [Create] to create a new project.
The project is created and will open automatically.

Select Open Project view.

Select Options > Manage general station description files (GSD).

Online |Opti0ns |TDD|S Window Help
¢ = 0 1 settings ‘e ¥ Goo

Support packages

Manage general station description files (G5D)

T Start Automnation License Manager

s | HMl cor
#| Show reference text sy

w1 1] Global libraries ]
e L []

Navigate to the folder where the generated GSDML (see Creating a GSDML import fileD® ) is stored,
tick the check mark of the file and click [Install].

Click [Close].
The Hardware Catalog is updated.

Double-click [Devices & Networks] to open the Network View.

26
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10.  Open the Hardware Catalog.

11.  Select Other field devices > PROFINET IO - Gateway - Softing Industrial Automation GmbH >
Softing Process Automation Gateways.

12.  Select the project name you entered in Step 3.

13. Select DAP.

Options

LI

~ | Catalog

|-:5ea rch= ”E @
[ Filter
» [ Contrallers
v [ Hw
4 E[. FC systems
» [ Drives & starters
» [ Network components
] rj] Detecting & Monitoring
v (i Distributed 110
] r;. Field devices
« (1 Other field devices
~ (1l PROFINETIO
» [ Controllers
» (i Drives
» (1§ Encoders
- r‘_!. Gateway
» [ SIEMENS AG
- [E. Softing Industrial Automation GmbH
» (il Softing pnGate PA
~ (1l Softing Process Automation Gatewsys
~ [ Fieldbus Proxy
Il oaF
[ BL
Il o4F (vi0.0)

I oA (v1.10.0) I

14.  Select Version in the information dialog to identify the correct GSDML by date and time stamp.

5]

15.  Select the gateway, drag it from the Hardware Catalog and drop it into the Network View.
16.  Click [Not assigned] in Network View.

17. Select the controller.

= Topology view ||EE'E| Network view |||]T Device view |
= _J Network overview |4 | b

(] =
= 'ff Device
* S71S00/ET200MF sta..
pnGatePA B » CPUIS16
Sy * G50 device_1
DAP (v1.10.0} 2 - P;
Sy 25 nGate
MSEIEU 10 controller = P
CPU1516.PROFINET interface_1
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18.

19.

20.

Now the gateway is assigned to the controller

CP1516_pnGatePA » Devices & networks

CPU1516.PROFINET I0-5y___

ﬁ—gﬂ Netwark E_E Connections |HI- Il cannection |'| @ : !'-l;, e @‘l 3
CPU1516 pnGatePA
CPU 1516-3 PNL.. DAP (V1.10.0)
CPU1516

Double-click the gateway icon to open the Device View.

|E Topology view "531[ MNetwork view |||]'|‘ Device view \_

may

JDevice overview ‘

]

'ﬁ' IMedule
¥ pnGatePA
* Interface
Ethernet Port 1
Ethernet Port 2
* Fieldbus Access Points (2 xP_.
Fieldbus Access Points (2.
Fieldbus Access Points (2.

=]
=1]
=
=

= I = S = T == B B = S = M = WS = B = T = 1O = 5 = |

Slot

0 DAP..
0 DAP...
D DAP...

1
11
12
2

3
4
5
&

=

| address =

Drag a module to a free slot. The supported submodules are shown under Submodules.

Click the gray device symbol and select a submodule (e.g. temperature value) from the catalog to
open the corresponding Properties dialog (configure the parameters of the submodule if required -

similar to PA Function Block).

28
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21.

22.

vm Head module
~ [ Fieldbus Proxy
[l o2P (vi.10.0)
vtﬂ Module
» [ Endress + Hauser
» (i Endress+Hauser
Fieldbus Access Points (1 xPA)
[l Fieldbus Access Points (2 xPA)
m Fieldbus Access Points (2 xFA, 1 xDF)
[l Fieldbus Access Points (4 xPA)

[l vEGAsON 50
[l vecason 50
» [ wika
'5 Submodules
~ [l VEGAFULS 40/50
Il 21 (PA-0UT, long)
[ 41 (FA-OUT, short)

Enter the Slave Address.

Options (EE
S

(-5

v | Catalog 5
|¢Search:\- “E@ 5
[ Fileer g
S

[.Fieldbus Access Points (4 xPA, 1 xDF}) :ﬂn_"
» (il KROHNE Messtechnik GmbH =
] [f. Metso Automnation [
» [l PROFIBUS-PA Profile (i)
» (i@l PROFIdrive e
» Tﬂ Softing z'-
~ ([l VEGA Griechaber KG §

Il veGAPULS 40/50

s]00] auljuQ E”

Select Slave Proxy = General > Module parameters and set the PROFIBUS master channel to the
channel to which the PROFIBUS device is connected.

If required, you can configure the parameters of a submodule in this dialog window after selecting it

(corresponding to PA Function Block).

Fieldbus Access Points (2. o 12 s |
— T _VEGAPULS 40i50_1 o 2
- _ | Slave proxy | o 21 i
gy 5 AIFAOUT, long) [ 22 o
m i i i 5
v o q
& (] 5
o -3
o 7
o 8
o 9
o 10
o n
[ 12
(] 13 ol
] 100% fl g ] I I d_
‘ﬂl’mperties H‘_i.‘.lnfo y‘lﬂ Diagnostics ‘
I General I 10 tags H System constants H Texts ‘
~ General

Module parameters

Catalog information
|dentification & Maintenance

Module parameters

Hardware identifier

Slave Channel/Address assignment

FROFIBUS Channel [0.4]: |0
slave Address: |1
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23.  Select the default PROFINET IP address settings or click the gateway to configure these settings in
Properties > General.
Note
Do NOT to use the same IP address for the gateway and the device's web server. Example:
192.168.0.10 is the web server's default address. Use a different IP address for the
PROFINET. For information on how to change the web server's address refer to Changing the
18
IP address of the PROFINET GatewavD .
B [>][100% Bl ——v— &3] i ] B
[l Properties [} Info i) | %) Diagnostics
[ Gereral | 10tags | System constants [ Texts | N
T — g
w PROFINETinterface [X1] Interface networked with B
General
Subnet: | PNIE_1 |52}
Identification & Maintenance [ T —
~ Advanced options
e bt
s Hes
7 Em:::ﬁ Port 1 [X1 P1R] (® SetiP address in the project
b EthernetPort 2 [X1 P2 R] IPaddress: [ 192 .168.0 .2 |
e -
Hardware identifier
() IPaddress is set directly st the device
24.  Save the project and download it to the device.
25.  Select the corresponding PC network interface where the controller is connected.
26.  Click [Load] and [Finish] to complete the setup.

Toad preview X
9 Check before loading
Status |1 Target Message Action
41 & ~ crisis Ready for loading.
] » Stop modules The modules are stopped for downloading to device. stop all
] » Software Download softwsre to device Consistent download
] Text libraries Download all alarm texts and text list texts Consistent download
[¢] I [2]
| Refresh ]
| [ lead 1| cancel |

A confirmation window appears displaying the message Downloading to device completed

without error.
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4.7.4

4.7.4.1

4.7.4.2

4.7.4.3

Updating and uploading a GSDML file

If you add new PROFIBUS device to a segment in the gateway user interface you will need to update the
GSDML and upload it to the PROFINET engineering tool (TIA portal) using the update feature of the TIA
portal to avoid the loss of I/Q address parameter.

Generic GSDML

The following steps describe how to add a new PROFIBUS device and update the generic GSDML (see also
Chapter Generating a GSDML import fileD? ).

1. Log on to the the user interface of the gateway with your username and password.
2. Select PROFIBUS > Configuration.
3. Import the GSD file of the PROFIBUS device to the Device Catalog in the gateway user interface.

4. Click [Generic GSDML] to generate the new GSDMIL file.

GSDML
See also the videos Conversion from PROFIBUS GSD to PROFINET GSDMIL.

1. Log on to the the user interface of the gateway with your username and password.

2. Select PROFIBUS - Configuration.

3. Import the GSD file of the PROFIBUS device into the Device Catalog in the gateway user interface.
4, Assign the device to the PROFIBUS segment(s) in the Segment Configuration.

5. Add the 10 modules.

6. Set the PROFIBUS address.

7. Click [GSDML] to generate the new GSDML file.

Device catalog update in TIA portal

1. Open the TIA portal project.

2. Select the existing PROFINET gateway device in the Hardware Catalog under Other field devices >
PROFINET 10 > Gateway - Softing Industrial Automation GmbH > Softing Process Automation
Gateways.

3. Import the new GSDML which you can identify by the date and time string in the file name.

4. Select in the left side menu Devices > Devices & network.

5. Select the gateway you want to update in the Device view - Devise overview window.
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T Siemens - C:\Users\GEN4ClDesktop\TestiTest —ax
st Edit Vew et Onine Optons Toos Mindow u:lv Totally Integrated Automation
Cf i svepoiest @ X 18 3 X 0 (4t 5 MG B R Y coonline F Gooiine dp M IB | 3 () [Ceoch vy ] PORTAL
Test » Ungrouped devices > pnGatePB [DAP] — X
Devices. [ Topology view |g Network view _|[I¥ Device view ||t
= - E
& 4 (]2 | d¢ [proasers oarl v B (e ar Zi | [Deviceoverview || p= g
AW woaue e Fock [Siot[1address |Q adres rype i e H
s =i o o osr V13000
I\ device b Interiace o oo pnGaters
I
[EoeTEe T ] n = Fieldbus Acces: Point @xP-. 0 1 . viz000
(cRI=16]| RN TS PHDEY Fieldbus Access Point (2. 0 " V1.30.00
[ TCa TG e Fieldous Access Foint 2.0 12 V13000
%) Online & diognostics |
» g8 Software units <[ >/ [100% ~] <] A
» 5 rogrem blocks [ roperties [ info_0] U Diagnostics H
» [ Technology objects 3
[ e aT=oliee s General | 10tags | Systemconstants | Texts | 3
» L@ rctog ~ Genersl o B
eneral
» [ PLCdota opes Cotalog informaton L
» 53 Wotch and force tables ~ PROFINETintersce [X1] =
» [ig Online backups General tame: [pnGoters H
» [ Traces Ethemetaddresses nuthor: [genic &
[ OFC UA communication dentiction & Neintenance L
ST ~ Advanced option: oI |5
Interface options c
Medio redundancy H
5 » feoltime setings Mz
» [ Local modules » Ethemetfort 1 [x1 P1] L —
» [ Distributed 1l0 » Ethemetport2 [x1 P2R] Slot: [0 [
» '3 Ungrouped devices denticstion & Meintenance
Catalog information
» [ Languages & resources [oae
» (g Online access Descrption: [FROFIEUS Fieldbus Frosy
» (5 Card ReaderlUss memory
< [oetaits view sicene: [
Fimvare version: (V130,00
Hordware product version: 100
Nome D fle: [gsdml2 34-oftng pngateps-20200113-152555 i
ei20ge revizion ]

« poraview

6. Click the [Change revision] button in the Catalog information window.

7. Select the GSDML file imported in Step 3 (check date and time string) in the new window that
appears.
GSD file - change revision %

Available revisions

GSD file Wersion | Revision
gsdmlv2.34-#softing-pngatepa-20191108-132227 xml v2.34  11/8/2019 1:22 PM
gsdmlv2.34-#softing-pngatepa-20191108-134854.xml v2.34  11i8/2019 1:48 PM
sdml-v2.34-#softing-pngatepa-20200113-152555.xml ¥2.34  1/12(20203:25 PM
gsdmlv2 34-#softing-pngatepa-20200113-153323.xml v2.34  1/13(2020 3:33 PM E

a 5]

Use selected revision for

(®) the current 10 device
() All matching 10 devices of the |0 system
() All matching 10 devices of the current project

Compatibility information
Information
Q pnGatePB: Change version ‘gsdml2.34-#softing-pngatepa-20200113-152555.xml".

| oK || Cancel |

8. Instantiate the new PA device module and assign the correct parameter to the new device if you
imported a generic GSDML.
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4.7.5

4.7.5.1

4.7.5.2

4.7.5.3

Switching from a 2-channel to a 4-channel gateway

You can switch from a 2-channel to a 4-channel gateway to support more PROFIBUS devices in your
network. To do this it is recommended to use the Change Revision in the TIA portal feature.

Generic GSDML

The following steps describe how to switch from a 2-channel to a 4-channel gateway and how to update
the generic GSDML (see previous cha pter?” ).

1. Log on to the the user interface of the gateway with your username and password.
2. Select PROFIBUS > Configuration.

3. Import all GSD files of the PROFIBUS devices from the 2-channel gateway into the device catalog of
the 4-channel gateway.

4. Click [Generic GSDML] to generate the new GSDMIL file.

GSDML

The following steps describe how to switch from a 2-channel to a 4-channel gateway and how to update
the GSDML (see also the video Conversion from PROFIBUS GSD to PROFINET GSDML).

1. Log on to the the user interface of the gateway with your username and password.
2. Select PROFIBUS - Configuration.

1. Load the existing PROFIBUS configuration project of the 2-channel gateway into the 4-channel
gateway.

2. Click [GSDML] to generate the new GSDML file.

Device catalog update in TIA portal

1. Open the TIA portal project.

2. Select the existing PROFINET gateway device in the Hardware Catalog under Other field devices >
PROFINET 10 - Gateway - Softing Industrial Automation GmbH > Softing Process Automation
Gateways.

3. Import the new GSDML file which you can identify by the date and time string in the file name.

4. Select in the left side menu Devices > Devices & network.

5. Select the gateway you want to update in the Device view - Devise overview window.
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» [ Language: & rezources o R TR 57 41
DI Gl ~ Defapilots_i o s
» [ Cord ReaderlUse memory e rroy -
. o 52 a2
. S o s =
~ [ Details view @m) (3] [100% Fl —y— &[] u | SIS
|6 Properties [ Info 1] % Diagnostics [ra— 5
|| General [ 10 tags | System constants | Texts |
e » General M ~ =
General H
Name: [Fieldbus Acces: Point (2 x PA and 1 xOP)_1
suthor: |genic
S T | ]
| version: =

« poratview

6. Remove the 2-channel FAP module (Fieldbus Access Port) from the selected gateway. The FAP
module is always located in slot 1.

7. Click the [Change revision] button in the Catalog information window.

8. Select the GSDML file imported in Step 3 (check date and time string) in the new window that
appears.
GSD file - change revision %

Available revisions

GSD file Version |Revision
gsdmlv2 34-#softing-pngatepa-20191108-132227 xml v234  11i8i12019 1:22 PM
gsdml2 34-#softing-pngatepa-20191108-134854 xml v234  11/8/12019 1:48 PM

sdml-v2.34-#softing-pngatepa-20200113-152555 xml v2.34 111312020 3:25 PM
I gsdmlv2.34-#softing-pngatepa-20200113-153323 xml v2.34  1/M13/2020 3:33 PM I E
[<] i 2]

Use selected revision for

(®) the current 10 device
() All matching 10 devices of the 10 system
() All matching 10 devices of the current project

Compatibility information
Information

@& pnGatePB: Change version ‘gsdml-2 34-#softing-pngatepa-20200113-152555 xml",

| Ok || Cancel |

9. Instantiate the new PA device module and assign the correct parameter to the new device if you
imported a generic GSDML.
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5 Asset management

According to I1SO 55001, asset management deals with the entire life cycle of assets an organization
requires to achieve its objectives. But what is an asset? In the broader sense of the term, an asset is a
physical or non-physical entity, item or thing that has the potential or actual value to an organization. Seen
in the context of process automation, asset management involves controlling and governing physical
assets (device assets) to lower costs and improve plant performance.

The following chapter describes the tools and technologies of the Asset Management System which use
PROFINET Gateway to manage (configure, parametrize, troubleshoot and maintain) connected field
devices.

5.1 Preparing for asset management

Installation
. Install the most recent version of PROFIdtm or PDM library from the PROFINET Gateway product
website.

PROFIBUS Configuration for PROFIdtm and PDM

1. Click the Windows Start E button to open the start menu.

2. Select Softing PROFIBUS - Driver Configuration to configure the PROFIBUS driver.

3. Allow Windows User Account Control (UAC) to modify settings.
The PROFIBUS Control Panel is opened.

4, Select the PROFINET Gateway and click [Add...].
5. Enter a symbolic name and click [Next].
6. Enter the IP address of your PROFINET Gateway and click [Next].

7. If required, change the timeout settings (Timeout for Connect and Max Idle Time).
In most cases default settings can be used.

8. Click [Finish].
The configuration wizard is closed. In the Control Panel the node name is shown on the left side
underneath the PROFINET Gateway. The question mark on a yellow background means that the
connection to the PROFINET Gateway has not yet been tested.

9. Confirm your settings with [Apply] and [OK].
The PROFIBUS Control Panel tests the connection to the PROFINET Gateway. After a short while,
the yellow question mark is replaced by a green check mark. If a red cross appears instead, check
the network cables and the IP settings of your PC and the gateway. Ensure that the PC and the
PROFINET Gateway are on the same IP subnet.

10. Continue with Chapter Creating a project in PACTware.
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5.2

5.2.1

5.2.2

Asset management with PACTware

PACTware is an FDT frame application which allows you to view field devices of different suppliers in a
graphical interface similar to a browser window. To manage the information of these devices, PACTware
uses a Device Type Manager (DTM) within the frame application. The DTM is a software which allows you
to access a field device similar to a device driver. It contains the complete logic (data and functions) of the
field device. Using DTMs the same device setting procedures can be used in any FDT environment.

For details on how to set PROFIBUS device parameters see the online manual integrated in the most recent
PROFIdtm application you downloaded and installed from the product website.

Prerequisites

The default IP address of the built-in web server has been changed to an address on your network or the IP
address of your PC has been changed to an IP address corresponding to the network address of your
gateway (e.g. 192.168.0.1). See Chapter Setting the IP address of the PC .

. PACTware 4.1 or any other FDT frame application is installed.

= PROFIdtm is installed.

Creating a project

1. Start PACTware.

2. Create a new Project and save the project.

3. Right-click Host PC > Add Device in the device tag column of the project view.

Device tag

S HOST PC

Connect

*
+

R

Disconnect

Topology Scan

Diagnostic Scan

Up-/Download-Manager

Add device

I

A new window appears with the available devices.

4, Select PROFIdtm DPV1 from the list and confirm with [OK].
The device is displayed in the project view.

36
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All Devices

Device 4| Protocol Vendor Group

'.' smartLink HW DP HART Softing Industrial Automation GmbH OTM specific
<

IEI : Softing PROFIBUS Master Interface
: Device Data Base for Softing DP-Master PBpro
:Date :24-August-2008

oK . Cancel

Note
Before starting a topology scan ensure that suitable Device DTMs are installed for the
connected PROFIBUS devices.

5. Right-click PROFIdtm and select Topology Scan.

6. Click the arrow in the scan window to start the topology scan.

| Scan Path

YHOST PCy <0, PROFIdtm>PROFIdtm DPV1

Scan Tree

Device tag Address | Device type (DTh
{s PROFldtm 0| PROFdtm DPV1

PROFIdtm and the detected PROFIBUS devices are displayed in the scan window.
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Scan Path

\HOST PC\<0,PROFIdtm>PROFIdtm DPV1 Issue: Selecta DTM

SeariTiee Matching % « | Support level
1 Profibus 100| Specifi

WEGAPULS 42 Profibus 100 Specific

WEGAPULS 43 Profibus 100 Specific

VEGAPULS 44 Profibus 100 Specific
WEGADI S AS Drefikuie 10N Srarific

Save assignment for all devices of same type

Semantic ID Scan info Device Type inf »

Device tag | | Address | Device type (DT
8 bl 0 PROFIdtm DPV1

Bl Protocel Profibus DP/V1 Profibus DPNl
H Tag
1 Serial number

7. Close the scan window. The detected PROFIBUS device has been added to the project view.
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5.3 Asset management with Simatic PDM

With the SIMATIC PDM, Siemens provides a framework for managing more than 4,500 field devices
regardless of what type of automation and control system is used. SIMATIC PDM is an open software tool
for devices from over 200 manufacturers. To integrate a field device in a framework you need to import its
Electronic Device Description (EDD), a file containing all relevant device data. This file is typically available
for download on the device manufacturer website.

53.1 Prerequisites

=  The default IP address of the built-in web server has been changed to an address on your network.
Alternatively, the IP address of your PC has been changed to an IP address corresponding to the
network address of your gateway (e.g. 192.168.0.1). See Chapter Setting the IP address of the pch®

=  EDD files and libraries of the PA devices have been imported into the PDM Device Integration
Manager (DIM). If not available, download these files from the Siemens support website and import
them into the DIM.

=  The PDM libraries of the Softing PROFIBUS have been downloaded from the product website and are
installed.

5.3.2  Connecting to SIMATIC PDM
Connecting the SIMATIC Manager with the smartLink HW-DP device:

1. Start the SIMATIC Manager from the Windows start menu to create a new project: Start > All
Programs > Siemens Automation > SIMATIC - SIMATIC Manager.

2. Click Options > Select PG/PC Interface.
A new window with a dropdown menu is opened.

3. Select from the dropdown menu Interface Parameter Assignment used > Softing PROFIBUS
Interface PROFIBUS.1.

4, Set the timeout value to 60s and confirm with [OK].

5. Check the board number to ensure that it corresponds to the number in the node name.
See Section Preparing for asset ma na;zementD35 .

6. Click [OK].
You will return to the main window (Component View).

Note
A logical connection has now been established between the smartLink HW-DP and the
SIMATIC Manager.

7. Go to View > Process Device Network View.

!; SIMATIC Manager - [PDM_sample_new (Component view) -- C\Program Files (x86)\51

23 File Edit Insert PLC Options  Window  Help

O BT & | 4 Ex| ¢ Componentview Fiter
[E—

Process Device Plant View

Process Device Metwork View
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10.

11.

Right-click on the configuration symbol in the Process Device Network View and select Insert New
Object > networks.

# SIMATIC Manager - [PDM_sample (Process Device Network View) —- C:\Program Files (8¢

% File Edit Insert PLC View Options Window Help

| &3 || < No Fiter >

N |26 4 2R | da|l? % %[8

----- FDM_sampge .

% Cut Chrl+ X
Copy Cirl+C
Paste Ctrl+V
Delete Del
Insert Mew Object r ‘
PLC

Right-click on the network symbol and select Insert New Object > Communication network.

# SIIATIC Manager - PDM sample (o Device Network View) - C:\Program Files 686\ ST

% File Edit Insert PLC View Options Window Help

(D= |26 4 2w dal|o 2 %] & |[<Ne Ater> 1% |
% FD_zample |
----- B PO sam
Open Object Ctrl+Alt+0
Cut Ctrl+X
Copy Ctri+C
Paste Ctrl+V
Delete Del
Insert Mew Object Communication network Il

Click [Assign Device Type...].
The Assign Device Type window is opened.

Select PROFIBUS DP network.

Insert Object - Assign Device Type

Device Type

-l Networks
Ui ETHERNET
(-l HART
(- HART server
(- MODBUS

El I PROFINET

Ci @ PROFIBUS DP
. [ Bm PROFIBUS DF networks

) PROFIBUS DP network

Description:
Order Numbar;

Status:

ok ] |

Cancel

40

Version EN-032024-1.31-1



Chapter 5 - Asset management

12. Click [OK] to continue.
You are back in the Process Device Network View.

13. Right-click PROFIBUS DP network - SIMATIC PDM - Start LifelList in the left column.

% File Edit Inset PLC View Options Window Help

|HCNOFiher‘- _'J“"’J‘%

= FDM_sample
= D_szample_network
WD

Open Object Ctrl+Alt+0

Cut Ctrl+X

Copy Cirl+C

Paste Ctrl+V

Delete Del

Insert New Object 4

Access Protection 2

SIMATIC PDM 12 Export...
Rename F2 LT

Object Properties... Alt+Return Load to Device...

Load to PG/PC...
Update Diagnostics...
Start LifeList

Show change log...

14. Click the Start Scan () iconin the top left corner under the menu bar.
This will run a network scan to verify that the PROFIBUS device can be reached.
The icon (] ) indicates that a device can be reached to read and write process parameters.

{4 Lifelist - PROFIBUS DP network

File Edit Device View Options Help
B . Bl [ | Min, address 120 Max. addre

Accessible nodes Address  Manufacturer

El- &= PROFIBUS DF network | |
o 125 | VEGA Grieshaber KG

15. Close the window in the top right corner (=2ss).

16. Right-click PROFIBUS DP - Insert New Object > Object in the network view.
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17.

18.

19.

20.

21.

22.

.‘1 SIMATIC Manager —"[lii)M_sample.ﬂ.’locss Device Network View) -- C\Program Files {ﬁﬁ}\s'lémem\’:'}‘le;
% File Edit Inset PLC View Options Window Help
| D= | 27 |da || 2

75?% PDM_sample
E a

FDM_sample_network
B whD
5]

< No Fiter > _"i

Open Object Ctrl+ Alt+0
Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+V
Delete Del

Insert Mew Object 4 | Object I

Access Protection 3

SIMATIC PDM 3

Rename F2

Object Properties... Alt+Return
1

Click [Assign Device Type...].
A new window opens.

Insert Object - Assign Device Type M

Device Type

E1-fi VEGA Grieshaber KG B
Il VEGAFLEX 50
Il VEGAFLEX &
Il VEGAFLEX 80series Rev.1 DD Rev.2
[l VEGAFLEX 80series Rev.2 DD Rev.1
- VEGAPULS 40/50

8 Y VECAPULS Sene 40 i

[l VEGAPILS Serie 50

-] VEGAPULS 61 Rev.2 DD Rev.2
-] VEGAPULS 62 Rev.2 DD Rev.2
-] VEGAPULS 63 Rev.2 DD Rev.2 m
- {J] VEGAPULS 65 Rev.2 DD Rev.2
-] VEGAPULS 66 Rev 2 DD Rev.2
-] VEGAPULS 67 Rev 2 DD Rev.2
-l VEGAPULS 68 Rev 2 DD Rev.2 fu
Description: VEGAPULS4D

i

Ornder Number: siehe unter www vega com

Status:
Action finished without emors -

Device identification ]

[ ok | [ cameel |

€ 4

Select the device you want to access from the device type list and click [OK].

Enter the PROFIBUS address.

Click [OK] to confirm.
The window is closed.

Right-click in the Process Device Network View on the device you have just selected and select

Object.

This opens the SIMATIC PDM view which shows the parameter values of the selected device.

Click the Measured Value Display ( &) icon underneath the menu bar to import the parameter

values of the PROFIBUS device into the Process Device Manger.

42
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File Device View Diagnostics Options Help
FICEREEICT S IEE
i S Parameter |Vaiue
EIVEGAPULS 40
Class | Echo Level
[l Identification
Certificates and Approvals El0peration Unit.
[#-"| Sonsor optimisation (VEGA specific)
TAG |\c"egap|.||5
e e e e

Congrats. You are done.
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54

Asset management with ABB FIM

ABB Field Information Manager (FIM) is a device management tool which makes configuration,
commissioning, diagnostics and maintenance of fieldbus instruments easier and quicker than ever before.

This chapter describes how to connect and use the communication server ABB FIM Bridge PROFINET to
access PROFINET devices.

1. Double-click the ABB FIM icon to start the application.

ADRD
ADPD
|::> Field Information Manager

Version 2.4

Manag

When you start the application for first time, the ADD COMMUNICATION SERVER popup window
appears. Here you are prompted to select and add a remote Communication Server.

&3 ADD COMMUNICATION SERVER X

Local Communication Server

Local Communication Servers are used to communicate with devices connected to local modems.
Note: Muitiple local Communication Servers active at the same time might cause interferences.

COMMUNICATION SERVER TYPE NAME
() HART isHRT FDI Communication Server HART isHRT FDI Communication Server
O PROFIBUS isPro FDI Communication Server PROFIBUS isPro FDI Communication Server
[ uMc usB serial Communication Server UMC USB Serial Communication Server

Remote Communication Server
Remote Communication Servers are used to communicate with devices connected to remote systems.

COMMUNICATION SERVER TYPE NAME IP ADDRESS PORT
ABB FIM Bridge PROFINET ABB FIM Bridge PROFINET 32796
O Thorsis HART-IP FDI Communication Server Thorsis HART-IP FDI Communication Server 61669
[j ABB FIM Bridge 800xA ABB FIM Bridge 800xA 32794
D ABB FIM Bridge symphony Plus ABB FIM Bridge Symphony Plus 32795
f;] ABB FIM Bridge OPC-UA ABB FIM Bridge OPC-UA 32797
() Thorsis isNet Pro FDI Communication Server Thorsis isNet Pro FDI Communication Server 4840
]:j Thorsis isNet HART FDI Communication Server Thorsis isNet HART FDI Communication Server 4840
() other communication Server Other Communication Server

ADD CANCEL

2. Select the communication server type ABB FIM Bridge PROFINET and enter your PROFINET IP

address.

3. Click [ADD] to continue.

A new window appears. Here you see in the Results column if the selected communication server
has been added successfully.

44
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ADD COMMUNICATION SERVER

RESULT MESSAGE

ABB FIM Eridge PROFINET SUCCEEDED

4, Click [OK] to continue.
If you manged to connect to the communication server the Topology window appears.

Note

Repeat Step 2 if the connection to the communication server failed in Step 2. Make sure
you enter a correct IP address.
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5.4.1 Importing a pnGate PA FIMlet

1.

Download the pnGate FIMlet file from the PROFINET Gateway product website to the Downloads

folder on your PC.

Click the Menu icon = in the top left corner.

Select DEVICE CATALOG from the menu to import the FIMlet.

ABB Field Information Manager - pnGatePA

Q x e}
Maximize Tree  Minimize Tree  Display all Gateways  Add Server
X
DEVICE CATALOG
L]
DASHBOARD °
°
.
BEl
°
°
.
CONFIGURATION
+
- =
L =
PROJECTS oo
- o
REMOVEALL fij ¢
o B Notifications.
(© UPDATING REPOSITORIES FINISHED 7/6/2023 3:12:06 PM CANCEL RESULTS 51
ABB Field Information Manager - pnGatePA
= =1 a
=— Ssearch Q| Local Packages 4 Yy x = o
= Save Filter  Reset Filter Offline Repository Handling  FieldComm EDDs  Refresh
DEVICE CATALOG visible 18 / 2085 select /BB Packages X
(@ Y DEVICETYPE (ID) ABB Repository Packages  &TION 'Y PROTOCOL Y CLASSIFI... Y TYPE Y REVISION Y SUPPOR... Y INUSE
Local Packages
O [ ceneRric Qaas2) ] HART7 Universal Generic DeviceP... 02000007 All supported (@)
(@] L’f} GENERIC (0x9700) ABB Local PROFIBUS PA Universal Generic Device P...  01.00.00 All Supported @)
(@] [vﬁ GENERIC (0x9701) ABB Local PROFIBUS PA Universal Generic Device P...  01.00.01 All Supported (@]
O [ ceneric xeron BB Local PROFIBUS PA Universal Generic DeviceP... 010002 All supported ®
O | () HART-IP FDI Communic. Thorsis Technol...  Local HART Network Compo...  Specific Device... 108 Not Available (@]
O [ sHRT FoIGommunicati.. l Thorsis Technol...  Local HART Network Compo...  Specific Device... 1013 Not Available @)
(@] @J 1sPro FDI Communicati.. Thorsis Technol... Local PROFIBUS DP Network Compo...  Specific Device... 108 o0 (@] A
H
9 pnGate Softing Local FIMLET Network Compo...  Specific Device.. 100 ane
Gate . i 1 K ific Devi
O [ Profinetcommserver BB Local PROFINET Network Compo...  Specific Device... 228702 Not Available
O | uMc UsB gerial Commu Thorsis Technol...  Local PROFIBUS PA Network Compo...  Specific Device... 101 120 (@]
oo

INFO CENTER

Select the filter setting Local Packages.

Click the Import « icon in the menu bar.
The IMPORT FILE(S) window appears

In the IMPORT FILE(S) window scroll to the Downloads folder.

Select the Softing pnGate 1.x.x FIMlet file.

Click [Import].

REMOVEALL {i @
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Al Field Information Manager - Mick_4
— o a
= Search Q| Local Packages A Yy s o (&3
— SaveFilter  ResetFilter | Import  Offiine Repository Handling  FieldComm EDDs  Refresh
DEVICE CATALOG (visible 18 / 2097 selected 0) X
(O Y DEVICETYPE(ID) Y MANUFA.. Y LOCATION Y PROTOCOL Y CLASSIFI... Y TYPE Y REVISION Y SUPPOR... Y INUSE
0 ‘ [) FimBrid ‘ ABB. Local GENERIC Network Specific Device... 220 Not Available
O [ eeneric | ame Local,

0O |[f sEneric | aes Locall e
e » esktop
] GENERIC ABB Local =
ol(@ ‘ DV Donro ] EH Cerabar_S_pMx_x3x_PA V10
=
] GENERIC (0x1A82) ABB. Local| =
0 ‘%‘ e ] EH Cerabar_S_PMx_x3x_PA V2.0_V2 2
v omputer
) GENERIC ABB Local
@) ‘LL] J o & [E] softing pnGate 100 fimiet
v ] system (c:
(@] GENERIC | aes Locall
= [£] 6SDML-v2.:34-#Softing-pnGatePA-20230118-133229.xmi
» [ ABB Industrial IT Data
O [ seneric gxoron | aee Local
3 St 7 il — [£] GSDML-v2:34-#S0fting-pnGatePA-20230118-135927.xml
» [ ABB Certificate
GENERIC (0x9701) | aee Local
WA R memtaands] PR RS [£] GSDML-v2.24-#Sof ting-pnGatePA-20230118-150044.xm!
» ] pata
O |1 HaRT-P Fpl Communic... | Thorsis Technol...  Local
S e 48 All Device Descriptions (*.FDIX; *.FM8; *.FIM...
O [ 1strT FoICommunicati... Thorsis Technol...  Locall
4E 'vse
POR
eoe
INFO CENTER REMOVEALL § @

The IMPORT RESULTS window appears. Here you can see if the selected file was imported
successfully.

9. Click [OK] to continue.

IMPORT RESULTS

NAME CATEGORY FILE INFORMATION IMPORT MESSAGE

Softing.pnGate.1.0.0.fimlet FIMLET C:\Users\800xAlInstaller\Desktop SUCCEEDED Device Package signing problem
(MotSigned).;

The Softing pnGate FIMlet file is now included in the catalog with the device type name pnGate.

— a = p b . ) K] g O
esetFiter  import  Offine Repostory Handiing  FieldComm EDDs _ Refresh
CATALOG visble 2062 2082 selected 1 x | sHoRTcuTs
¥ osviceTveE (D) JMAWRA. 4 ViocAON  YRROTOCOL Y CLASSFI e Yrevson  ysueor viuse  yomeor v
SWISAWSTRUM...  Fiedcomm Grou... | HARTT e speciceon 110 1
SwANAmial. | Fiedcomm Grou.. | HART Anaitic specticzoo 110 1 0
surcon Fedcommorou.. HARTT Actimtor ecro.. | specificoevie,. | 00100
surcon Fdcomm oo || HART? S specitcomvice,. | o000 .
StoneL Corporat . Fedcommrou.. | HART? Actuator specfceon 140 e
stausmstrume... | Fiddcommarou.. | HART Temperswe  spearcsop oo oes 0
Staws nstrume... | Fiedcomm Grou... | HART Temperawe  speciicEod 110 1
SpifaxsarcoSRL  Fieldcomm Grou...  HART Actuator specific £00 130 100 0
— Pidcomm arou.. | WART? - specticzoo 110
:

Sha ‘spectrex FieldComm Grou. HART 7 Analytic ‘specific Device. 010100 1 0 nd

E— Fidcomm Grou.. HART? anac specfcen 120 e
e Fidcomm ou... AT anaiic speciceon 140 s 0
Spartngstrum...  Fldcomm Grou... | HART Fow specticzoo 110 1
saantTerison | Fiekicommarou... || HaRT? e spectcsoo | 110 o

SPAANLITPRIBOR | Fiedcomm rou.. | WARTT anatic specfcEon 110 1o
son Fiedcomm crou.. | HART? — specceon 110 1 0

© proete Softing Local FmieT Network Compo... ~ Specific Device.. | 100 10 o s/17/2023
s Fedcomm Grou.. HARTT Actuator [ 2o 0
e Fedcomm rou... | HART e specticzoo 120 1
canren .
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5.4.2 Creating a project

1. Click the Menu icon = in the top left corner.
2. Select the PROJECTS menu to create a project.

3. Click the plus icon @ at the top of the window.
The New Project window appears.

@
NAME

Mick
DESCRIPTION

[Test )

8 PROJECT MANAGEMENT

(> SYNCHRONIZATIONS
§ TRACK CHANGES
I PROCESS COCKPIT

LOOP CHECK SETTINGS

g 'MPORTLOOP CHECK
SETTINGS

Local Communication Server

CCOMMUNICATION SERVER TYPE
() HART isHRT FDI Communication Server
(O PROFIBUS isPro FDI Communication Server

(O UMC USB Serial Communication Server

Local Communication Servers are used to communicate with devices connected to local modems.
Note: Multiple local Communication Servers active at the same time might cause interferences.

NAME

HART iSHRT FDI Communication Server

PROFIBUS isPro FDI Communication Server

UMC USB Serial Communication Server

Remote Communication Server
Remote Communication Servers are used to communicate with devices connected to remote systems.

CCOMMUNICATION SERVER TYPE NAME

1P ADDRESS POF
ABB FIM Bridge PROFINET ABB FIM Bridge PROFINET 172.2014.5 327¢
(O Thorsis HART-IP FDI Communication Server Thorsis HART-IP FDI Communication Server 616¢

) ABBFIM Bridge 8

4. Enter a Name and a Description in the top two rows.

5. Tick the checkbox for ABB FIM Bridge PROFINET and enter the IP address of the PROFINET adapter
onthe PC (e.g.172.20.14.5) in the IP ADDRESS field.

6. Click [ADD] to continue.

A NEW PROJECT popup window appears. In this window, the result and message line next to your
project name shows if the project has been added successfully.

7. Click [OK] to continue.

NEW PROJECT X

NAME

[Micks ]

DESCRIPTION
[Tests ]

Local Comy NEW PROJECT

Local Com

Note: Muld NAME RESULT MESSAGE

Co
Micks SUCCEEDED The project has been created successfully.
O Ha

ABB FIM Bridge PROFINET SUCCEEDED

ODR
O um

Remote Ci
Remote C
COf [OF
ABH o7
O Ttho

ABI

48

Version EN-032024-1.31-1



Chapter 5 - Asset management

The Project Management window is displayed listing all existing projects.

ABB Field information Manager - Micks 8 B X

@ BACKTO MAIN PROJECT MANAGEMENT

Provides access to create, save or switch projects.

8 PROJECT MANAGEMENT © o m B [ P

S e NAvE oEscRIPTION creaTeD MODIFIED

T TRACK CHANGES 6/13/2023 o/13/2023

8 PROCESS COCKPIT pnGatePA pnGatePA 6/13/2023 7/6/2023
Micks Tests 7/6/2023 7/6/2023

LOOP CHECK SETTINGS

g IMPORTLOOP CHECK
SETTINGS

8. Click the arrow icon in the top left corner to return to the main menu.
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5.4.3 Scanning for a PROFInet device
1. Click the Menu icon = in the top left corner.
2. Select the TOPOLOGY icon Y .
3. Select the Softing pnGatePA entry in the topology tree view
4, Move your mouse pointer left to HARDWARE SCAN and select SCAN THIS LEVEL.
ABB Field information Manager - Default
B
5. In the FIM window to the right the SOFTING pnGatePA/PA/.. is displayed.
6. Click the three dot icon =+ beneath the name and select LIST ALL DEVICES.
All PROFIBUS devices connected to the pnGate are visualized.
ABI e information Manager - Dafault
B
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5.4.4

Accessing a PROFIBUS device

1. Select a PROFIBUS device you want to work with and click the three dot icon === inside the device

box.

= search

ToPoLOGY

= search

TopoLOGY

v  [ZilrsaFMadoePrOFINET
v [Eicoocasagarac
[ Softing pygte PA/PS).

[55]Ae8 F sggoe ProFINET |

v [Soscagc |
I Softing pogste PA/PS/.

ABB Feld information Manager - Default

Q =l =l x

Maximize Tree  Minimize Tree  Displayall Gateways  Add Server

Device Type (D)
Protocol PROFIBUS PA
Generic Device Package
Universal
010002

Classification
Package Revision

Device Type (D)

GENERIC (0x9701)

CA[TAG PR Sigve s

Manufacturer (oxo1n)
Device package informat

Device Type (D) GENERIC (0x9701)
protocol PROFIBUS PA

Tye Generic Device Package
Classification Universal

Package Revision 010002

C)[TAGPAC Sigve &

Device Type (D)

Manufacturer

(ox01)

Classification Universal

GENERIC (0x9701)
PROFIBUS PA
Generic Device Package

Package Revision 010002
Ca[TAcPAL
Device Type (10)
Manufacturer (o)

Select DEVICE SETTINGS.

B Fild information Manager - prGatePA

Q

MaximizeTree  Minimize Tree  Displayall Gateways  Add Server

GENERIC (0x9701)
PROFIBUS PA
Generic Device Package

GENERIC (0x9701)
PROFIBUS PA
Generic Device Package

Classification Universal
Package Revision 010002
TGP0 s

Device Type (D)

Manufacturer ©xoun

GENERIC (0x9701)
PROFIBUS PA
Generic Device Package

Classification Universal
Package Revision 010002

. £3[TaG Pa0: Slave 6

H evice Type (10)

5 Device Type (D)
Manufacturer (o1
Device Type (1D) EnERIC (0xs701)
Protocol PROFIBUS PA
Type Generic Device Package
Classification Universal
Package Revision 010002

I {3 [TacPaz:gaye7

Device Type (12)
Manufacturer (oo

Device Type (1D)

protocol PROFIBUS PA
Classification Universal
Package Revision 010002

GENERIC (0x9701)

Generic Device Package

The DEVICE SETTINGS shows the parameter values read from the device.

ABB Field information Manager - Default
= [Oberogre )

“DEVICE- TAG PAD: SLAVE 4 /DEVICE SETTINGS

[ vyzmue | oetaledseti  Simuation identicaion

Analog Input
Tag

Channel

Outout value
nit
Upperrange value:
Lower range value.
Limit Hysteresis
Diagnostic Status
Linearization
General
Wirite Locking

Installtion Date

test999

a7

Is ||

100000)% .

000]%.

Linear

I;

.

Status FaLAl

h

|

Process value

[ 3

2 WLowcriticalalarm

2 Dtow advisory slarm

2 WGood

2 OHigh advisory alarm
WHiioh criticalalarm

DEVICE SETTINGS.

o= )

Version EN-032024-1.31-1
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3.

4.

Set the Write Locking parameter to On.

“DEVICE- TAG PAO: SLAVE 4 /DEVICE SETTINGS

Easysetup | Detalledsetup  Simulation Identification

Analog Input

gmitsstesss g ogu
e
F= 7 ) l
0 ) == =
[@]
El
<4 - ’v
m (o [o)([Cowo Jo)(C wo= ]
Click [SEND].
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Chapter 6 - LED status indicators

LED status indicators

The PROFINET Gateway displays eight device status LEDs and two RJ45 connection status LEDs on the

front side:

Device status LEDs

PWR RUN

o
O

ERR  CFG

PN
SF  BF

@ O
O

SF  BF
PA

=  power supply - refer to next section
= running - refer to next section
= error - refer to next section
=  configuration - displays configuration upload - refer to next section

RJ45 status LEDs

54
54
54

[154

= system faults - displays Modbus/PROFIBUS system faults (wrong configuration,
internal error, ...)
= bus faults - displays Modbus/PROFIBUS bus faults

The device status LEDs are permanently on or flash in different colors and frequencies as indicated below:

Symbol Color Lighting
@ none off

. red permanent
! green permanent

8 red flashing (1 Hz)

c red flashing quickly (5 Hz)
8 green flashing (1 Hz)

G green flashing slowly (0.5 Hz)
c green flashing quickly (5 Hz)

The RJ45 status LEDs indicate the following behaviour:

|

Symbol Color Lighting
. green permanent when Ethernet
connection is on
yellow flashing when Ethernet connection i

active

Version EN-032024-1.31-1
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6.1 Status LEDs (PWR, RUN, ERR and CFG) in stand-alone mode
LEDs Meaning
PWR RUN Start-up phase (approximately 10 seconds)
ERR CFG
PWR RUN Operating system starts (approximately 2 seconds)
ERR CFG
PWR RUN Device is running in factory mode (only firmware update is possible)
ERR CFG
PWR RUN Device is running/operational
ERR CFG
PWR RUN Software error
. . A software error occurred. Reboot the device. Refer to error description in
. ® web browser (Diagnosis > Logfile > Support Data).
ERR CFG
PWR RUN Permanent hardware fault detection during startup
A fatal error has been detected. Refer to error description in web browser
(Diagnosis = Logfile - Support Data).
ERR CFG
PWR RUN Software error occurred, device has restarted automatically and error is
reported in log file
Delete log file in web browser (Diagnosis > Logfile & Support Data).
ERR CFG
PWR RUN Firmware update is running (in factory mode if blinking red)
@ O0¢
ERR CFG
PWR RUN No power on device
Check power supply.
ERR CFG
54 Version EN-032024-1.31-1
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6.2 PROFINET device LEDs (PN)

An error such as a software errorD* or a license error has occurred.

LEDs Meaning

SE BF No connection to controller

® . Possiblg causes: PROFINET ha.me is missing on the gateway or the physical
connection to the gateway is interrupted.

SE BF Connection establishment

® c Time peri.od the.system needs to establish a connection; devices cannot yet
communicate with each other.

SE BF Connected to controller

® . All devices are exchanging data.

SE BF Configuration error or diagnosis

_Q , Read errors from PROFINET engineering system.

SE BF PROFINET signal function active

¥ 09

33 BEF Error in the PROFINET part of the device

[

6.3 PROFIBUS master LEDs (PA)

LEDs Meaning
® . All channels offline
SF BF
® . All devices exchange data on all channels
SF BF
® 8 8 At least one used channel is not online
/
SF BF
8 . 8 At least one slave is not in data exchange
/ (BF: green - all channels are online; red: not any channel is online.)
SF BF
. . Error in the PROFIBUS part of the device
An error such as a software errorDd® or a license error has occurred.
SF BF

Version EN-032024-1.31-1
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7

Declaration of conformity

This device is compliant with EC directive 2014/30/EG, "Electromagnetic Compatibility" (EMC directive)
and meets the following requirements:

] EN 55011 Industrial, scientific and medical (ISM) devices - radio disturbance -

OMPLIANT

AER> @

VEl

limits and methods of measurement

EN 55032 Electromagnetic compatibility of multimedia equipment (MME) and interference

emission

EN 61000-6-4 Electromagnetic compatibility (EMC); Part 6-4: generic standard —

emission for industrial environments

EN 61000-6-2 Electromagnetic compatibility (EMC); Part 6-2: generic standard -

immunity for industrial environments

Note

To fulfill the EMC requirements, the other components of your installation (DC adapter,
Industrial Ethernet devices, etc.) also have to meet the EMC requirements. A shielded cable
must be used. In addition, the cable shield must be grounded properly.

CAUTION
This is a Class A product. In a domestic environment this product may cause radio
interference in which case the user may be required to take adequate measures

CE
The CE marking indicates conformity with the above standards in a Declaration of
Conformity which can be requested from Softing Industrial Automation GmbH.

RoHS

This product is compliant the Restriction of Hazardous Substances under Directive
2002/95/EC-

FCC

This equipment has been tested and found to comply with the limits for a Class A digital
device, under part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference when the equipment is operated in a commercial
environment. This equipment generates, uses, and can radiate radio frequency energy and, if
not installed and used in accordance with the instruction manual, may cause harmful
interference to radio communications.

VCCI

This Class A product conforms to the regulations of Voluntary Control Council for
Interference (VCCI) by Information Technology Equipment.

WEEE

In compliance with Waste Electrical & Electronic Equipment (WEEE) Directive 2002/96/EC,
electrical and electronic equipment must be disposed of separately from normal waste at
the end of its operational lifetime. Packaging material and worn components shall be
disposed of according to the regulations applicable in the country of installation.
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8 Glossary

DC Direct Current - electric current flowing in only one direction

DIN Deutsches Institut fiir Normung

DTM Device Type Manager

DP Decentralised Peripherals

EDD Electronic Device Description. A file created by the device manufacturer or a
service provider. It is shipped together with the device on a data carrier and /
or made available for download from the Internet by the manufacturer.

EDDL Electronic Device Description Language

ETH Ethernet

Ex Explosion protection

FDT Field Device Tool

GND Ground

GSD General Station Description. A file containing general data about the
configuration of a PROFIBUS field device as provided by the device
manufacturer. The GSD file is required so that a PLC can communicate with a
PROFIBUS field device.

GSDML General Station Description Markup Language. A GSDML file contains general
and device-specific data for communication with and network configuration
of PROFINET I/O devices.

1/0 Input/Output

IP Internet Protocol

PA Process Automation

PB PROFIBUS

PDM Process Device Manager (sometimes aka Plant Device Manager)

PLC Programmable Logic Controller

pnGate PROFINET gateway

RDL Redundancy Link

T temperature

TIA Totally Integrated Automation

Version EN-032024-1.31-1
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